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FOR PRODUCTS PURCHASED IN UNITED STATES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS

Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have or intend to have on your network. For
computers or workstations attached to a public messaging system, the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS

You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION

You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
education or charitable institution pricing program, you may not
create an extra copy of the Software under this provision for use on a
home or portable computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY

This Software is licensed AS IS. If for any reason you are
dissatisfied with the Software, return the product package, with
proof of purchase, to your reseller within 90 days for a full
refund. If any materials or media in this package are defective,
return them to Novell within 90 days of the date of purchase, and
they will be replaced at no charge.

These warranties are in lieu of any other warranties, express or
implied, including the implied warranties of merchantability and
fitness for a particular purpose. In no event will Novell be liable
to you for damages, including any lost profits, lost savings, or
other incidental or consequential damages arising out of your use
of or inability to use the Software, even if Novell or an authorized
Novell representative has been advised of the possibility of such
damages.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions that may supersede this limitation of liability
and may not apply to you if prohibited by the laws of your
jurisdiction.

CUSTOMER SUPPORT

Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL

If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions. This Agreement shall be governed by
the laws of the State of Utah.

U.S. GOVERNMENT RESTRICTED RIGHTS.

The Software and any accompanying materials are provided with
Restricted Rights. Use, duplication, or disclosure by the Government
is subject to restrictions as set forth in subparagraph (c) (1) (ii) of The
Rights in Technical Data and Computer Software clause at DFARS
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial
Computer Software-Restricted Rights at 48 CFR 52.227-19, as
applicable. Contractor/manufacturer is Novell, Inc., at the address
below.

ANY QUESTIONS?

If you have any questions concerning the terms of this Agreement,
please refer to the Questions and Answers which follows this
Agreement. If you have further questions about this Agreement or
about special programs for educational or charitable organizations,
please write to WordPerfect, Novell Applications Group, Attn. Sales
Center, 1555 N. Technology Way, Orem, Utah 84057-2399, or call
(801) 225-5000.



FOR PRODUCTS PURCHASED IN ALL OTHER COUNTRIES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS

Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS

You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

HOME OR PORTABLE COMPUTER PROVISION

You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on
which you use the Software.

If you have licensed this Software under an education or charitable
institution pricing program, you may not create an extra copy of the
Software under this provision for use on a home or portable
computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If any materials or media in this
package are defective, return them within 90 days of the date of
purchase, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT
WILL NOVELL BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OF OR INABILITY TO USE
THE SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions which may supersede this limitation. As a
result, this limitation of liability may not apply to you if
prohibited by the laws of your jurisdiction.

CUSTOMER SUPPORT

Subject always to Novell's current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL

If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?

If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organizations, please
contact your local WordPerfect office or authorized distributor or
write WordPerfect, Applications Division of Novell, Inc. Attn. Sales
Center, 1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.,
or call 801/222-4200.



FOR PRODUCTS PURCHASED IN AUSTRALIA-NEW ZEALAND
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS

Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS

You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

HOME OR PORTABLE COMPUTER PROVISION

You are authorised to use a copy of the Software on a home or
portable computer, provided the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software.

If you have purchased this Software under an educational institution
or charitable institution pricing programme, you may not create an
extra copy of the Software under this provision for use on a home or
portable computer.

LIMITED WARRANTY/LIMITATIONS OF LIABILITY

A. This Part A is subject to provisions of Part B which follows
below. This Software is licensed AS IS. If any materials or media in
this package are defective, please return them within 90 days of the
date of purchase, and they will be replaced free of charge.

These warranties are in lieu of any other warranties, express or
implied, including the implied warranties of merchantability and
fitness for a particular purpose. In no event will Novell be liable to
you for damages, including any loss of profits, lost savings, or other
incidental or consequential damages arising out of your use of or
inability to use the software, even if Novell or an authorised Novell
representative has been advised of the possibility of such damages.

B. Trade Practices Act. Where any legislation such as the Trade
Practices Act 1974, implies into this Agreement any condition or
warranty and that legislation avoids or prohibits provisions in a
contract excluding the application of the condition or warranty, the
liability of Novell for any breach of the condition or warranty is
limited at the option of Novell to any one or more of the following:
a) if the breach relates to goods, replacing the goods or the payment
of the cost of acquiring equivalent goods or repairing the goods or
payment of the cost of repairing the goods; b) if the breach relates to
services, the supplying of the services again or the payment of the
cost of having the services supplied again.

Nothing in this Agreement is intended to restrict or exclude any
liability of Novell under Part VA of the Trade Practices Act 1974.

CUSTOMER SUPPORT

Subject always to Novell's current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL

If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?

If you have any questions concerning the terms of this Agreement or
special programmes for educational or charitable organisations,
please contact your local WordPerfect office or authorised distributor
or write WordPerfect, Applications Division of Novell, Inc. Attn.
Sales Center, 1555 N. Technology Way, Orem, Utah 84057-2399
U.S.A., or call 801/222-4200.



FOR PRODUCTS PURCHASED IN UNITED KINGDOM
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS

Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS

You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

SPECIAL PROVISIONS

Novell grants you a special licence to place an extra copy of the
Software on a home or laptop computer, as long as the extra copy is
never loaded at the same time the Software is Loaded on the primary
computer on which you use the Software.

Special licensing provisions may apply for a qualified educational of
charitable institution.

LIMITED WARRANTY/LIMITATION OF LIABILITY

If you enter into this Licence agreement as part of a consumer
transaction: if any materials of media in this package are
defective, return them within 90 days of the original date of
purchase and Novell will replace them at no charge. THE
FOREGOING DOES NOT AND WILL NOT AFFECT YOUR
STATUTORY RIGHTS AS A CONSUMER.

If you do not enter into this Licence Agreement as part of a
consumer transaction: THIS SOFTWARE IS LICENCED AS IS.
If any materials or media in this package are defective, return
them within 90 days of the original date of purchase and Novell
will replace them at no charge. The right to use the Software is
granted without any further warranty, condition, representation
or other term express or implied relating to the performance,
quality or fitness for use of the Software or written materials
accompanying the Software. Novell shall not be liable for any
loss or damage of any kind (other than personal injury or death)
arising from use of the Software or accompanying written
materials or from errors, deficiencies or faults therein, whether
such loss or damage is caused by negligence or otherwise.

CUSTOMER SUPPORT

Subject always to Novell's current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL

If any provision of this Agreement shall be unlawful, void, or for any
reason unenforceable, then that provision shall be deemed severable
from this Agreement and shall not affect the validity and
enforceability of any of the remaining provisions.

ANY QUESTIONS?

If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organisations, please
contact your local WordPerfect office or authorised distributor or
write WordPerfect, Applications Division of Novell, Inc. Attn. Sales
Center, 1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.,
or call 801/222-4200.



FOR PRODUCTS PURCHASED IN CANADA (ENGLISH)
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS

Novell, Inc (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS

You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

HOME OR PORTABLE COMPUTER PROVISION

You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on
which you use the Software.

If you have licensed this Software under an education or charitable
institution pricing program, you may not create an extra copy of the
Software under this provision for use on a home or portable
computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY

This Software is licensed AS IS. IF FOR ANY REASON YOU
ARE DISSATISFIED WITH IT, RETURN THE SOFTWARE,
INCLUDING ALL MATERIALS, WITH PROOF OF
PURCHASE TO NOVELL WITHIN 90 DAYS OF THE DATE
OF PURCHASE FOR A FULL REFUND. If any materials or
media in this package are defective, return them within 90 days
of the date of purchase, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT
WILL NOVELL BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OF OR INABILITY TO USE
THE SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED
NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions which may supersede this limitation. As a
result, this limitation of liability may not apply to you if prohibited
by the laws of your jurisdiction.

CUSTOMER SUPPORT

Subject always to Novell's current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL

If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?

If you have any questions concerning the terms of this Agreement,
please refer to the Questions and Answers which follows this
Agreement. If you have further questions about this Agreement or
about special programs for educational or charitable organizations,
please write to WordPerfect, Applications Division of Novell, Inc.
Attn. Sales Center, 1555 N. Technology Way, Orem, Utah 84057-
2399, or call (801) 225-5000.



CONTRAT DE CONCESSION DU DROIT D'UTILISATION
DES LOGICIELS EN VERSION FRANCAISE ACHETES AU CANADA

TERMES ET CONDITIONS D'UTILISATION

Novell, Inc. (Novell), vous concede le droit d'utiliser le Logiciel,
conformément au nombre de copies et a la plate-forme spécifiés par le
Formulaire de preuve d'achat inclus dans le coffret du Logiciel. Sile
Logiciel constitue une mise a jour d'un produit de WordPerfect, Novell
vous concede le droitd'utiliser la présente version ou la version antérieure
du Logiciel, mais non ces deux versions simultanément. Le présent
Contrat de concession annule ou remplace tout contrat antérieur.

LOGICIELCLIENT Surles ordinateurs ou stations de travail connectés
aunréseau, le nombre de copies du Logiciel réputées «utilisées»
correspond au nombre maximum de boites aux lettres que vous étes
autorisé ainstaller. Surles ordinateurs ou stations de travail connectés a
un systeéme de messagerie publique, on considérera que le nombre de
copies du Logiciel réputées «utilisées» correspond au nombre maximum
d'ordinateurs sur lesquels le Logiciel est chargé en mémoire
simultanément, ou au nombre maximum d'ordinateurs sur le disque dur
desquels le Logiciel est enregistré.

LOGICIELDE SERVEUR DEMESSAGES Une seulelicence est
requise pour utiliser le Logiciel sur un serveur de messages, ou sur un
ordinateur, poste de travail ou serveur de fichiers faisant office de serveur
de messages, desservant tous les ordinateurs d'un domaine. Un
«domaine» estle regroupement logique de plusieurs bureaux de poste
et/ou passerelles gérés par un seul serveur de messages.

LOGICIEL DE PASSERELLE Destiné aux ordinateurs ou stations de
travail non connectés a unréseau, ou aux serveurs de réseau, le Logiciel
estréputé «utilisé» lorsqu'il est intégralement ou partiellement chargé en
mémoire vive ou en mémoire virtuelle, ou bien enregistré sur le disque
dur ou tout autre dispositif de stockage.

Vous étes autorisé a copier ladocumentation écrite, qui accompagne le
Logiciel, pour assister l'utilisation 1égale du Logiciel. Vous pouvez aussi
réaliser une copie d'archive du Logiciel pour chaque licence couverte par
le Contrat.

RESTRICTIONS

Vous ne pouvez en aucun cas louer ou céder en location le Logiciel sans
I'accord écritde Novell. Vous ne pouvez en aucun cas décompiler,
démonter, inverser, reproduire, créer une oeuvre dérivée, ou autrement
utiliser le Logiciel en dehors des cas expressément prévus dans ce contrat.
Quel que soit le nombre de supports inclus avec le Logiciel, vous n'étes
autorisé a utiliser que le nombre de copies indiqué sur le Formulaire de
preuve d'achat. L'achat de ce Logiciel peut étre réglementé par des
conditions spéciales, imprimées sur 1'emballage contenant le Logiciel.

DISPOSITIONS RELATIVES AUX ORDINATEURS PERSONNELS ET
AUX PORTABLES

Vous étes autorisé a utiliser une copie supplémentaire du Logiciel sur un
ordinateur personnel ou un ordinateur portable. Cette copie ne doiten
aucun cas étre chargée sur cet ordinateur personnel ou portable lorsque le
Logiciel est déja chargé sur votre ordinateur principal.

Sile Logiciel a été acheté dans le cadre d'un programme d'éducation ou
caritatif, vous n'étes pas autorisé a réaliser une copie supplémentaire du
Logiciel pour votre ordinateur personnel ou portable.

GARANTIES-LIMITATIONS DE RESPONSABILITES

CE LOGICIEL VOUS EST CONCEDE EN LICENCE EN L'ETAT ; SI
POUR UNE RAISON QUELCONQUE, VOUS N'ETES PAS
SATISFAIT, VOUS DISPOSEZ D'UN DELAI DE 90 JOURS, A
COMPTER DE LA DATE D'ACHAT, POUR RETOURNER LE
LOGICIEL, Y COMPRIS TOUS COMPOSANTS RELATIFS,
ACCOMPAGNE DU FORMULAIRE DE PREUVE D'ACHAT A
VOTREREVENDEUR, ET VOUS SEREZ INTEGRALEMENT
REMBOURSE. En outre, Novell s'engage A remplacer gratuitement toute
disquette ou élément défectueux contenu dans I'emballage qui sera
retourné dans un délai de 90 jours, a compter de la date d'achat.

TOUTE AUTRE GARANTIE, EXPRESSE OU IMPLICITE, Y
COMPRIS TOUTE GARANTIE IMPLICITED'APTITUDE A LA
COMMERCIALISATION OU D'APTITUDE A UNE UTILISATION
PARTICULIERE, EST EXPRESSEMENT EXCLUE. EN AUCUN
CAS,NOVELL NE SAURAIT ETRE RESPONSABLE DES
DOMMAGES DIRECTS OU INDIRECTS, Y COMPRIS TOUTE
PERTE DE PROFIT OU DE BENEFICE OU AUTRES DOMMAGES
INDIRECTS OU ACCESSOIRES CAUSES PAR L'UTILISATION OU
LTMPOSSIBILITE D'UTILISATION DU LOGICIEL ET CE, MEME
SINOVELL OU L'UN DE SES REPRESENTANTS AGREES A ETE
AVERTI DE LA POSSIBILITE DE TELS DOMMAGES.

Certaines juridictions ne permettent pas 1'exclusion ou la limitation de
garantie implicite ou lalimitation de responsabilité pour des dommages
indirects ou accessoires. En outre, certaines juridictions prévoient des
dispositions particulieres relatives a la protection du consommateur,
lesquelles pourraient remplacer les dispositions qui précedent. En
conséquence, lalimitation de responsabilité peut, conformément & la loi
en vigueur dans votre juridiction, ne pas vous étre applicable.

ASSISTANCE TECHNIQUE

Dans le cadre de sa politique d'assistance technique, Novell s'efforcera de
répondre aux questions d'ordre technique concernant le Logiciel.
Cependant, il est convenu que ce service ne constitue qu'une obligation
demoyen et que Novell ne saurait satisfaire toute demande d'assistance.
Novell ne supportera le Logiciel que dans la mesure ou celui-ci est utilisé
dans les conditions et selon les configurations matérielle et logicielle pour
lesquelles il aété concu. Les services offerts par 1'Assistance technique
peuvent étre altérés sans préavis.

GENERAL

Aucas ot unedisposition quelconque de ce contrat seraitillégale, nulle
ounon exécutoire, pour quelque raison que ce soit, cette disposition sera
réputée non écrite, etla validité et le caractere exécutoire des autres
dispositions de ce contrat n'en seront pas affectés.

REPONSES A VOS QUESTIONS

Si vous avez des questions a propos de ce Contrat, ou a propos des
conditions spéciales accordées aux établissements scolaires et aux
organisations caritatives, veuillez contacter la filiale dont vous dépendez,
ou votre distributeur agréé, ou écrire a WordPerfect, Applications
Divisionof Novell, Inc., Attn. Sales Center, 1555 N. Technology Way,
Orem, Utah 84057-2399 U.S.A., ou appelez le (800) 321-2318.



Questions and Answers

Q. How do I license for the use of workstations located on my network?
Can I license based on concurrent access to the system?

A. Each defined user on the GroupWise messaging system is assigned a
mailbox for persistent storage of calendar and electronic messaging data.
Each mailbox must be licensed and is considered "in use" after it has
been defined. Regardless of whether the user is actually logged into the
post office, the mailbox is actively available for delivery of messages,
processing of server-based rules, and other messaging services.

Q. If I have three users who share a workstation (they work on rotating
shifts), do I need one license or three to cover their use of the software?

A. If each of the three users has an individual mailbox, then three
licenses are required. If all three users share the same mailbox (defined
by job function, perhaps, rather than individual user), then only one
license would be required.

Q. Do I need to worry about which user runs the various Client
versions of the GroupWise software? If I'm migrating my users from
DOS to Windows, do I need to modify my license for the software?

A. No. Becausethelicensing of Client software is done on a per-mailbox
basis, any platform version of the GroupWise network Client software can
beused toaccess alicensed mailbox.

Q. If I have a user who runs the Client software on more than one
workstation, do I need more than one license?

A. No. Only one license is needed to cover access to the licensed
mailbox from one or more workstations.

Q. Am I required to license resources?

A. No. The resources defined on the GroupWise system do not need to
be licensed.

Q. How can I tell how many licenses I need?

A. The Administration program provides a count of all mailboxes
installed on the post office, domain, and system. The number of
licenses for which you are responsible equals the number of mailboxes
installed on the part of the system that is under your jurisdiction.

Q. How do I license my users who use the Remote Client versions of
the software?

A. The Remote Client software is licensed by the same mailbox license
mechanism used by Network Clients. Any platform version of the
Remote Client software can be used without additional licensing to
access any licensed mailbox.

Q. Can my users have a copy of the software loaded on their home
computer and laptop computer as well as on their network computer?

A. Yes. As long as all of these workstations where the software is stored
are used to access the same licensed mailbox, they can all operate under
a single mailbox license.

Q. How is the Administration software licensed?

A. There is no license tied specifically to the Administration software.
Itis provided in the Client package and can be used on any system that
contains licensed mailboxes.

Q. How are the multiple Message Server programs licensed?

A. The GroupWise Message Server software is licensed on a domain
basis by Message Server platform. Any and all Message Server programs
required for the operation of the GroupWise system on a supported
platform are licensed for use on a single domain. Additional Message
Server licenses are required for each additional domain serviced.

Q. Can I run the Message Server programs licensed under the domain
license on separate workstations or file servers?

A. Yes. As long as these programs are run to support the messaging
services of a single domain, they can run on one or more workstations
or file servers.

Q. If I want to run different platform versions of the Message Server
programs on the same domain (such as MS and ADS OS/2, and OFS
NLMs), do I need one license or two?

A. In this case, even though the servers are supporting a single domain,
you would need two Message Server licenses because the Message Server
is licensed by platform and two platforms of Message Servers programs
would be in use.

Q. How are the GroupWise gateways licensed?

A. The GroupWise gateway software is licensed on a per-installation
basis using the "loaded" and "stored" conditions previously described.
Each occurrence of each gateway installed must be licensed.

Q. Do I need multiple gateway licenses of any single gateway to service
the post offices and domains on my system?

A. Generally, one gateway per system will be sufficient to service the
needs of the entire system. If only one gateway is installed, it only needs
asingle license and any user on the system can use its services.

Q. We tunnel through the Internet using the SMTP gateway. How
many SMTP gateway licenses are required?

A. One license is required for each installation of that gateway. To
connect two sites via gateway tunneling, two installed and licensed
gateways must be used.

Q. 4.1 versions of the GroupWise gateways now allow me to run
multiple gateway processes on a single defined gateway service. How
many licenses do I need to support this configuration?

A. Where two or more gateway processes are "loaded" and executing as
separate processes, each must be licensed.
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Starting GroupWise

Before you begin using GroupWise 4.1 for Windows, formerly known as WordPerfect
Office, you will need to run the GroupWise Setup Program. You must first be in the
Windows Program Manager. The way GroupWise is installed depends on whether
you are updating from WP Office 4.0 or installing GroupWise for the first time.

Upgrading from
WP Office 4.0

If you are currently running WP Office 4.0 or 4.0a, you will get an upgrade message
when your system administrator upgrades to GroupWise on the network. The upgrade
message prompts you to install GroupWise 4.1.

If you are running WP Office from the network, GroupWise updates your Button Bars
and preferences. It also installs WPCSET.BIF in place of the WP Office .INI files and
the TrueType fonts necessary for WP Characters.

If you are running WP Office from your hard drive, GroupWise opens the GroupWise
Install program so you can choose a standard or custom installation. Go to Running
the Setup Programbelow and start at step 3 for instructions. The GroupWise Install
program updates your Button Bars and preferences. It also installs WPCSET.BIF in
place of the WP Office .INI files.

Running the Setup
Program

Your system administrator should already have told you the location of the setup
program (SETUPWIN.EXE). You need to know the location of the program before
continuing.

1 Make sure you are logged in as yourself at your computer.

2 From the Program Manager window, choose the File menu, choose Run, then type the
path to SETUPWIN.EXE in the Command Line box.

The path will look similar to this: NAOFFICE\OFWIN4O\SETUPWIN.EXE.
3 Choose OK to start the setup program.

4 Select the type of install you want in the GroupWise Install dialog box.

= GroupWise Install

I Local Drive
- 1 Installs all GroupWise files to a hard drive.
Standard Install Disk space required: 14 M

Allows you to select which files to install and
Custom Install to specify the destination locations.
Disk space requited: 11 M to 14 M

_ Installs files for minimal operation.
Disk space required: 11 M

[ Network

= Installs the group and icons necessary to
Workstation run GroupWise from the network server.

When the installation is complete, select the GroupWise program group for the
GroupWise program icons. If you want to place the GroupWise 4.1 item icons in a
different group, select the group from the pull-down list.

5 Choose OK.

Starting GroupWise 15



Starting
GroupWise 4.1 for
Windows

To start GroupWise,
1 Double-click the GroupWise program item icon in the GroupWise group.
2 When the Password dialog box appears, type your password if one has been assigned

to you, then choose OK.
or

If you don’t know your password, see your system administrator.

The GroupWise Main Window should now be displayed on your monitor. The Main
Window lets you open other windows to view incoming and outgoing items, open calendar
views for managing your schedule, and open views for sending mail, appointments, tasks,
notes, and phone messages. See A Brief Tour below.

= Novell GroupWise 4.1 & — The title bar shows the window
Pull-down menus ———————————File Edit View Send Tools Window Help name
|
_cli i % @ = Double-click icon button to open
D(?Lﬁ‘)/é click an icon to 0Pen 8 —— 50 Oubox Tissh | wrwingo Day ouble-click icon bu P
window.

The Shelf lets you place

= UZ RS =
views, macros, or applications — I ‘é : L E’ % <

in the Main Window so you
can open them quickly.

the new item view displayed in
the pop-up list.

iy Calendar Send Mo/ Schedule

Aszion Tas “adrite Mote Phone Me|sage

O, 3' Mail = Meeti ..QI Fhi Me. & .
- = i e fattach Preele 211 The pop-up lists let you choose

Personal Task the view each icon button opens.
Personal Task wfattach

A Brief Tour

Welcome to GroupWise 4.1 for Windows! This section provides you with a quick overview
of GroupWise 4.1 and helps you get acquainted with this guide.

The Main Window

16 A Brief Tour

With the intelligence of GroupWise, you now have the tools you need for electronic
messaging, as well as time and task management.

The Main Window is where you can access all the following tools:

= Novell GroupWise 4.1 H!
File Edit Yiew 3Send Tools Window Help
WP = [
@ ﬁ & Shelf

OutBox  Trash WPin 6.0 Day

My Calendar Send Mail Schedule Assign Task Write Mot Phone Message

7 % 9 # # B

Wesk Ql_ Mail ¢l Mesting QI Task 3' Hotice =! F‘honeMa...:I

Main Window

E=4 The In Box displays all incoming messages and requests. When your In Box icon
displays an envelope, that means there are new items to read and act on.

@ The Out Box displays all messages and requests you send. You can use the Out
Box to retract items you have sent, or to find out if an item has been delivered, opened,
accepted, declined, deleted, and so forth.

@ When your Trash icon appears full, it means you have deleted items from your
Calendar, In Box, or Out Box. Until it is emptied, the Trash stores all your deleted items,
allowing you to recover an item if you change your mind.



The Calendar is a personal planner and time management tool. There are several
predesigned calendar formats you can select from to manage your appointments, tasks,
and notes.

£=]

Send Mail is your basic messaging tool. However, you can also attach text files,
graphics, applications, sounds, movies, OLE objects, and GroupWise views to mail
messages and other item types.

] . .

Schedule is your personal and group appointment tool. People and resources (such
as conference rooms, company vehicles, and overhead projectors) can all be scheduled
for an event quickly and easily.

@I Assign Task can be used as a project management tool which makes organizing a
group effort as easy as identifying the tasks, people, and time frame needed to accomplish
the goal. You can also create a personal task list with this tool.

@ Write Note lets you post reminders, announcements, or requests for other users, as
well as create personal reminders for yourself. Use notes as reminders about upcoming
deadlines, holidays, and so forth.

@ Use Phone Message to send paperless phone or “While You Were Out” messages.

Shelf: Use the Shelf to customize GroupWise to your needs. For example, you can place
an icon from the Main Window or an application icon on the Shelf. The Shelf icons let you
open views, macros, filtered boxes, and launch applications quickly. See Shelfin the
GroupWise 4.1 for Windows Reference.

In Box and Out
Box Icons

Paper clip icon

The messages, appointments, or requests you send are called items. The following table
helps you identify and understand the icons associated with each item.

ltems Unopened Item Icon Opened Item Icon
Mail [lcon not shown)] [lcon not shown)]
Appointment [lcon not shown)] [lcon not shown)]
Task [lcon not shown)] [lcon not shown)]
Note [lcon not shown)] [lcon not shown)]
Phone Message [lcon not shown)] [lcon not shown)]

Items with accompanying attachments such as files or graphic documents are marked with
a paper clip icon in the In Box. An item with a sound attachment is marked with a speaker
icon.

Speaker icon

ade In Box H!
File Edit ¥Yiew Send Actions Tools Window Help
EFE Jason Tirell [From | Bubjeat | Date
£ 1954 & William Zimbriski (Ric Creale Agenda 09/14/33 06.07am |
B9 DocUpdates & Georja.Eagar Guesswhatlheard..  09/14/393 0956am
£ Reports = Doug Batemnan Fleasae send form 497 09/14/93 10:00am
g Andrea Jackson Recording Requested  09/14/9310:17am
% Tina Hardinger Irwentary of Personal S 09/14/93 12:00pm
= =
[&] | T . [Selected 1 Total 12 2

GroupWise Views

A view lets you display information. GroupWise includes three types of views.

Group views let you send mail messages, appointments, tasks, notes, or phone messages
to one or more users, including yourself if you want.

Personal views let you place appointments, tasks, or notes which involve only you, into
your Calendar.

A Brief Tour 17



Using This Guide

The User’s Guide is divided into two clear and simple sections to help you quickly learn the
tools of GroupWise:

Using GroupWise Basics: Refer to this section when you need quick, how-to information
on basic tasks. The tasks are grouped according to the icons in the Main Window.

Using GroupWise Remote: Explore this section for information on how to use GroupWise
Remote to communicate and manage your time and business tasks when you are away
from the office.

Mouse Actions You
Should Know

The table below lists some basic mouse actions you should know. If you use a left-handed
mouse, reverse the left or right instructions.

Action Mouse
Point Move the mouse until the tip of the pointer is positioned on the item
you want.

Release Lift your finger from the mouse button.

Click Press and release the left mouse button.

Right-click Press and release the right mouse button.

Shift-click Hold down the Shift key and click the left mouse button.

Ctrl-click Hold down the Ctrl key and click the left mouse button.

Double-click Rapidly click the left mouse button twice.

Drag Eold down the left mouse button, move the mouse, then release the
utton.

Reference Manual

Because of the power and flexibility of GroupWise, not all features or applications of the
program can be covered in this guide. By using the GroupWise 4.1 for Windows
Reference (subsequently referred to as the reference manual), you can find the answers
you will need about the specific features and functions of GroupWise.

Conventions

Icons

Some of the icons in GroupWise are unnamed in the interface. An icon within a step
guides you to the interface icon you need to choose to perform the task. The following
step shows what you might see in the manual.

1 Choose Proxy E‘ then choose the name of the user you want to proxy.

Bolded Words

Bolded words in steps or explanations indicate what you choose or select in the step. The
following step shows what you might see.

1 Choose the File menu, then choose Preferences.

Getting Help
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If you encounter problems using GroupWise, you can get help from several sources:

Online Help

Coaches

QuickTour

The Manuals

Your System Administrator or Help Desk
Customer Support



Using Online Help

Online Help gives you quick access to documentation without reaching for a manual. You
can access Help from wherever you are in GroupWise.

To access Help, simply choose the Help menu, or choose the Help buttons found in dialog
boxes, or right-click, then choose Quick Help.

Using the Help Menu
You can access any of the Help features below from the Help menu.
Menu Options Purpose
Contents Displays and explains a list of Help features. You can select

any underlined term to display the topic.

Search for Help On  Use to open the Search dialog box and find Help topics by
keywords or phrases

What Is Switches the mouse and keyboard into a context-sensitive
mode which lets you click screen regions or press keystroke
combinations to get help.

How Do | Explains how to perform common tasks.

Coach Steps you through many common tasks.

Macros Explains macro basics, programming and product commands,
and user-defined dialog boxes.

About GroupWise Displays your network and program information.

Using QuickTour

QuickTour is a short demonstration of GroupWise for Windows. As part of the installation
process, Setup asks if you want to view QuickTour. If you decide not to view it at that time,
or want to review it later, you can double-click the QuickTour icon on the Shelf.

Other Assistance

If you need assistance beyond what the Help features and the GroupWise manuals can
provide, contact your Help Desk or your system administrator. If they cannot solve your
problem, these individuals can contact Customer Support.

Getting Help 19
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Reading Items

Control-menu box

Item list box

All incoming items appear in your In Box. Item types include mail messages,
appointments, task, notes, and phone messages.

From the Main Window,

1 Double-click In Box (24,

2 Double-click the item you want to read in the Item list box.

File Edit View Send Actions Tools Window Help
E=lzson Tinel [From [Subject Date
1) +

X Tyrone Young Albert Cano 09/14/93 09:55am
El Georja Eagar Guess what | heard.... 09/14/93 09:56am

=E# Doug Bateman Flease send form 437 09/14/93 10:00arm
E« ChetJenking Inteace Changes 09/14/93 10:38arm
®  Tina Hardinger Inventory of Personal St 09/14/9312:00pm | #

[a] | [Selected: 1 [Totat 16

If you are reading all your items, choose the Actions menu, then choose Read Next to
read the next item or Read Previous to read the previous item.

3 Choose Close to return to the In Box.

4 Double-click the Control-menu box shown above to return to the Main Window.

Tips and Hints

Deleting Items Immediately

You can also delete items immediately after reading them. Choose the Actions menu,
then choose Delete while you're in the item view.

or

Choose Delete if you're in @ mail or phone message view. See Deleting Incoming
Items under In Box.

Access and Proxy Lists

You don'’t have to leave your items unattended if you expect to be away from your office
for an extended period. You can selectively grant rights to a proxy who can answer your
mail or other items on your behalf. See Letting a Proxy Manage Your Mailbox under
Sharing Mailboxes.

If you don’t want to give someone access to your In Box, you can create a rule that
forwards items to another user. See Rules in the reference manual.

Reading Attachments

22 Reading Attachments

An attachment is a file or OLE object which may contain text, graphics, applications,
sounds, or movies and is sent with an item.



In the In Box or Out Box, items with attachments are marked with a paper clip icon. Items
with sound annotations are marked with a speaker icon.

b In Box n!
File Edit View Send Actions Tools Window Help
|22 Jason Tirell From [Bubject Diate
Paper clip icon L +
E Tyrone Young Albert Cano 09/14/93 09:55am
El Geotja Eagar Guesswhat| heard.... 09/14/93 09:56am
X3¢ Doug Bateman Flease send form 497 09/14/93 10:00am
Speaker icon =l Chel Jenking Interface Changes 09/14/93 10:38am
#___ Tina Hardinger Inventory of Personal S 09/14/9312.00pm |
2] | [Selected: 1 [Total 18

From your In Box or Out Box,

1 Right-click the item with attachments, then choose Read from the QuickMenu.

2 If you want to read an attached file, right-click the attachment in the Attach box, then
choose View Attachment from the QuickMenu.

or

If the item has no Attach box, choose @ to open the Attachments dialog box, select
the attachment you want to read, then choose View.

.
Lets you open the attachment in
another application, such as
g WordPerfect for Windows
View !

T \L! —— Lets you view the attachment
within GroupWise

Attachments dialog box
3 If you want to listen to a sound annotation, double-click the sound indicator.

= Mail From: Richard Ballard [=]
File Edit VYiew Send Actions Tools Window Help

From:  [Richerd Ballard | e |
Subject: R ding R sted
[Recording Remueste |
Message: | The sound is found in the gray area of the item view. + =
Rephy
Sound indicator T Forward
=
+ Info
s ki If there is no sound indicator on
e the view, click the sound button to

= list the attached sound files.

|Date: 09/14/9310:32am

4 Double-click the Control-menu box to return to the In Box or Out Box.
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Tips and Hints OLE Attachments
The Object Linking and Embedding (OLE) feature lets you include charts, graphics,
spreadsheets, sound clips and many other types of information created in other
applications as attachments that can be linked or embedded.

To open an OLE attachment, right-click the OLE object in the Attach box, then choose
Open. See OLE in the reference manual.

Running Other Applications

If you can’t view an attachment, you can open the attachment in another application such
as WordPerfect for Windows.

To open the attachment from the item view, right-click the attachment in the Attach box,
choose Open. If there is no application associated with the file, type the command line in
the Application to Run box. The command line consists of the path or directory of the
application, and the executable program filename. If you select Make this Association
Permanent, GroupWise will use the application you specify the next time you open a file
similar to the current file.

= Attachment Association

Filename: ¢:\930913.C10
The above file is associated with the command below._ If you

desire a different association, change the command.
Application to Run: Help I

Type the command line here.

—:c:\wpwinﬁﬂ |

[C] Make this Association Permanent

Printing Items and Attachments

Use Print to print an item or its attachments. You can also print the items in a calendar
format. See Tips and Hints below.

From any item view,

1 Choose the File menu, then choose Print.

Item ltoms:
Attachments are marked by +. e e

To print the attachment from
the application it was created in — [ print Attachment From &

Your item is already highlighted in the Iltems box.
2 If you want to print the item, choose Print.

3 If you want to print the attachment, select the attachment in the ltems box, then
choose Print.

When you are printing the attachment, the Attachment Association dialog box opens if
the Print Attachment From Associated Application check box is selected. The

24 Printing Items and Attachments



Type a different path and
application filename here, if
desired.

application that GroupWise will run to print the attachment is displayed in the Application
to Run text box. Printing from the application will retain all formatting codes.

= Attachment Association

Filename: C-ACALEN.C10

The above file is associated with the command below. I you

desire a different association. change the command.

Application to Run: Help I
T lprin] B

Pzl

= Hake thie Assaciation Peimanent’

If you select the Make this Association Permanent check box, attachments with the
same extension (such as .wpg) can be printed from the same application in the future
without bringing up the Attachment Association dialog box again. A Preference setting
also affects the display. See Tips and Hints below.

Choose OK to run the application and print the attachment.

4 When you are done with printing, choose Close to return to the In Box.

Tips and Hints

Selecting Multiple Items

You can select several items and their attachments to print from the In Box, Out Box, and
the Print dialog box.

To select a continuous range of items, click the first item in the range, then Shift-click the
last item in the range.

To select non-continuous multiple items, Ctrl-click the items you want.
After selecting the items, proceed with the steps above.

Disabling the Attachment Association Prompt

From the Main Window, choose the File menu, choose Preferences, then double-click
Associations. Deselect the Prompt Before Running Associated Application check
box.

Printing Troubleshooting

If nothing prints, make sure your printer is selected and set up correctly. Choose File, then
choose Print Setup to select your printer, specify margins, paper source, paper size, font
orientation, and the number of copies you want to print. See Print Setup in the reference
manual.

Accepting or Declining Appointments, Tasks, and

Notes &

Accept or Decline lets you inform the sender of an appointment, task, or note whether you
are available or not. Opened and unopened items are distinguished by icons. See A Brief
Tour under Getting Started.

The text descriptions of these items remain italicized in your Calendar until you have
accepted or declined the items.

From the In Box,

1 Double-click the item in the ltem list box.

Accepting or Declining Appointments, Tasks, and Notes 25



2 Choose Accept or Decline

L Appointment From: Georja Eager
File Edit View Send Actions Tools Window Help

To: Igeona, EradleyA, Tulis, RichBa, Judith

|
From: Ieeorja Eager ‘ (:C:I | Accept
|
|

Place: IConference Room ‘ BC: I

Subject:  [Priorty Mesting

Message: [Friorities have changed. New relesss dates +

I Close allows you to respond later.

+

Start Date: [6o0i94 [ oo ][E]
Duration:  [30 Minutes =l

I ] [#]
Appointment view

3 If you decline, you may want to type a comment in the Comment box, then choose OK.

GroupWise sends an accept or decline status to the sender’s Information window. See
Tracking Item Information under Out Box.

Tips and Hints

Accepting with a Comment

If you want to type a comment to the sender when you accept an item, choose the Actions

menu, choose Accept with Comment, type a comment in the Comment box, then choose
OK.

Accepting or Declining from the Calendar

You can also accept or decline appointments, tasks, or notes from your Calendar. See
Accepting or Declining Appointments, Tasks, and Notes under My Calendar.

Deleting from the In Box

If you delete an item from your In Box, the sender’s Information window will display an
opened and a deleted status. If you want the sender of an appointment, task, or note to

receive an accepted or declined status, you should choose either Accept or Decline before
deleting the item.

Where Items are Moved to

When you accept an appointment, task, or note in your In Box, the item disappears from
your In Box. You can view the item in your Calendar. If you decline the item, it is moved
to your Trash. You can adjust the In Box Filter if you would like to see your accepted items
in the In Box. See Filterin the reference manual.

Undeleting

If you declined and deleted an item, but have now changed your mind, you can still

undelete and accept the item if you have not emptied the Trash. See Undeleting ltems
under Trash.

Replying to Mail and Phone Messages

After reading a mail or phone message, the Reply feature lets you respond to the sender
immediately without having to select the sender’s name from the Address Book. You can
also reply to an appointment, task, or note. See Tips and Hints below.

After reading the message,
1 Choose Reply .
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The To box is already
addressed to the sender of the
original item.

Message box

2 Select Reply to Sender to send a reply to the sender only.
or

Select Reply to All to reply to the sender as well as all the recipients.

3 If you want to include the item’s text, select the Include Message Received from
Sender check box.

4 Choose OK, then type a message in the Message box.
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5 Choose Send to send your reply.

6 Choose Close to return to the Main Window.

Tips and Hints

Replying to Appointments, Tasks, and Notes

While accepting or declining an appointment, task, or note, you'll be prompted to type in a
comment. To reply without accepting or declining, choose the Send menu, then choose
Reply. Continue with step 2 above.

If you want to add a comment when you accept an item, choose the Actions menu, then
choose Accept with Comment. The comment is not sent as a Reply. Instead, it appears
in the sender’s Information window.

Resending a Message

If you want to resend basically the same message with minor changes, see Resending and
Rescheduling Items under Out Box.

Forwarding Items

When you want someone else to read the item you have just received, use Forward.
When you forward an item, it is sent as an attachment to a mail message.

From the In Box,

1 Double-click the item you want to forward.
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The subject remains the
same, except that
“Forwarded” is added to the
end.

Message box

2 Choose the Send menu, then choose Forward.
or
If you are in an opened mail view, choose Forward .
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3 Choose Address to open the Address Book.

4 Select recipients for the Send To, Carbon Copy, and Blind Copy boxes by dragging
their names to the appropriate boxes.

5 Choose OK.
6 Type a message in the Message box.

7 Choose Send to forward the item.

Tips and Hints

Delegate

If you are unable to accept an appointment, task, or note, you can delegate the request
instead of forwarding the item. Delegating will send a delegated status to the sender’s
Information window. This way, the sender will know that you have transferred the
responsibility to another person. See Delegate in the reference manual.

Attachments and Object Linking and Embedding

If there are other files or objects you want to send with the item you're forwarding, use the
Attach feature. See Attaching Files under Send Mail.

You can also embed or link an object or file in an item you are sending. See OLE in the
reference manual.

Deleting Incoming Items &

28 Deleting Incoming ltems

You can delete any item from the In Box at any time. However, if you cannot accept a
scheduled item, you should consider using Decline rather than deleting the item from the
In Box. Deleting will only send a deleted status to the sender, and he or she will not know
if you've accepted or declined the request.

From the Main Window,
1 Double-click In Box @

2 Right-click the item you want to delete.



3 Choose Delete from the QuickMenu.
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4 Double-click the Control-menu box to return to the Main Window.
Tips and Hints Selecting Multiple Items

You can also select multiple items to delete.

To select a continuous range of items, click the first item, then Shift-click the last item in
the range.

To select non-continuous multiple items, Ctrl-click the items.

Deleting an Opened Item

After reading an opened item, you can delete it immediately. To delete the opened item,
choose the Actions menu, then choose Delete.

or
Choose Delete if it is available in the item view.

Undeleting

If an item has been deleted by mistake, it can still be recovered if you haven't emptied the
Trash. See Undeleting Items under Trash.

Creating Folders

Folders help you to organize and store your In Box and Out Box items. You can use
folders to group items by a specific task, project, person, or any other subject.

All the folders that you create are subfolders of the root folder. The Folder list contains the
same folders regardless of which view you are in, and any folder can contain subfolders.

Root folder

A plus (+) sign indicates the
presence of subfolders. Click
to open folders.

Subfolders

Nile Edit Yiew Send Actions Tools Window Help
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From your In Box or Out Box,
1 Choose the File menu, then choose Folders to open the Folders dialog box.

2 Select a parent folder in the Folder List box. The new folder you are creating will be
the subfolder of this parent folder.
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3 Choose Create to open the Folder Name dialog box.

4 Type the name of the new folder, then choose OK to add the folder to the Folder List
box.

5 Choose OK to return to your In Box or Out Box.

Tips and Hints Deleting Folders
To delete an unwanted folder and its contents, from the In Box or Out Box, right-click the
folder you want to delete. Choose Delete from the QuickMenu, select Folder(s) and
Contents, then choose OK.
Drag and Drop
You can use drag and drop to manipulate your folders. Drag and drop folders onto
another folder to make them subfolders.
To move an item in your In Box or Out Box from one folder to another, drag and drop the
item from the ltem list box to the Folder.
al, Qut Box ﬂ!
File Edit Yiew Send Actions Tools Window Help
== Jason Tirell “TD | Bubject |[Date |
Folder list box 1994 & CAROLB Unarchive fles 097137
(3 DocUpdates' ||£2  Gearja, Chet Keithk F Vacation Request 09147
3 Reports ¢28  Richha 09/157
Item list box <3 Chet Georje, Keithk, F - Wacation Request 09715/
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Resending and Rescheduling Items &

You can resend mail or phone messages, or reschedule appointments, tasks, and notes if
they are still in your Out Box. You may also want to retract the original item before
resending it. See Retracting Unopened Items under Out Box.

1 Double-click Out Box &34
2 Select the item to resend or reschedule from the Item list box.

3 Choose the Send menu, choose Resend, then edit the old message or reschedule the
item.

4 Choose Send .

You will be prompted to retract the original item. Mail and phone messages cannot be
retracted if they have already been opened by the recipient(s). Appointments, tasks, and
notes can be retracted any time, even after they have been accepted.

5 Choose Yes if you want to retract the original item.

Tips and Hints Items in the Trash

Items in the Trash need to be undeleted before you can resend or reschedule them. See
Undeleting Items under Trash.

Calendar

To reschedule items from your Calendar, including personal items, see Rescheduling
Appointments, Tasks, and Notes under My Calendar.

Finding an Item

If you have a long list of items in your Out Box, use the Find feature to search for the items
you want to reschedule.

Select the first item in the Item list box, choose the Edit menu, then choose Find. In the
appropriate box, type the string of words or characters that matches the text in your item.
Choose Find Next to start the Find process. See Findin the reference manual.

To Test: IType here to search by name. |

Subject Text: |Type here to search by subject. |

Message Text: |Type here to search by message. |

Find Hext I Findﬁlevinusl Cancel ! Help I

Retracting Unopened Items &

If the information in a mail or phone message has become outdated or is incorrect, you
can still retract the item if the recipient has not opened the item. You can also retract
appointments, tasks, or notes whether they have been opened or not.
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From the Out Box,

1 Right-click the item to open the QuickMenu, choose Delete.

= Delete tem
Delete From —
O Ihis Out Box Eee

O All In Boxes

® All Mailboxes:

2 Select All In Boxes to delete from the recipient’s In Box only.
or
Select All Mailboxes to delete from your Out Box and the recipient’s In Box.

3 Choose OK to retract the item.

4 Double-click the Control-menu box to return to the Main Window.

Tips and Hints

Before Retracting
Before retracting, you may want to check the item’s status to see if it is still unopened. See

Tracking Item Information under Out Box. A mail or phone message can be retracted only
if it is unopened.

Resending or Rescheduling

If you plan to resend or reschedule an item, you don’t have to retract the item as a
separate step. While resending or rescheduling, you will be prompted to retract your
original item. See Resending and Rescheduling ltems under Out Box.

Deleting Outgoing Items &

Control-menu box

Item list box

You should periodically delete any obsolete or unwanted items from your Out Box.
From the Main Window,

1 Double-click Out Box @

2 Right-click the item you want to delete.

3 Choose Delete from the QuickMenu.

The QuickMenu is activated
by the right mouse button.

i al» Out Box ﬂl
File Edit View Send Actions Tools Window Help
Bl Jason Tirrell “TD | Bubjert H—Dale 7
£ 1994 B3 Geojn, Chet Keithk P Wacation Request 057147
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Save...
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4 Choose OK to delete the item from This Out Box.

Delete from your Out Box only e

s e Delete from all recipients’ In
Delete from your Out Box and 8%:: 'Mam,,,m e Bsxitz om all recipients
recipients’ In Boxes ]

5 Double-click the Control-menu box to return to the Main Window.

Tips and Hints Cleanup Options

If you want GroupWise to periodically delete items from your In Box, Out Box, and
Calendar, choose the File menu from the Main Window, choose Preferences, then
double-click Cleanup. Select Auto-Delete After from the Mail and Phone, and
Appointment, Task, and Note group boxes, then type in the number of days for the
periodic cleanup.

[lllustration not shown]

Selecting Multiple Items
You can also select multiple items to delete from the In Box or Out Box.

To select a continuous range of items, click the first item in the range, then Shift-click the
last item in the range.

To select non-continuous multiple items, Ctrl-click the items.

Undeleting

If an item has been deleted by mistake, you can still recover it if you haven’t emptied the
Trash. See Undeleting Items under Trash.

Tracking Item Information &

From the Out Box, you can find out what actions have been performed on the items you've
sent.

For example, when a recipient opens an item from you, forwards the item to a GroupWise
user, then delegates the item to another user, GroupWise will inform you of these three
actions and when they occurred.

From the Main Window,

1 Double-click Out Box &34,
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Control-menu box

Delivery date and time
information

2 Double-click the item you want information on.

Opened date and time
information

List of recipients

. Information E
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wordPerfect 5.0 «[ T +
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3 Double-click the Control-menu box to return to the Out Box.

4 Double-click the Control-menu box to return to the Main Window.

Tips and Hints

Information You Can Access

The Information window for an item you have sent includes the following information about
the current item.

- ltem name, post office, and the sender’s user ID
 Date and time the item was sent

« Subject of the item

- List of all recipients by post office

- List of attached files including the MESSAGE file (The size of each file and the date
and time it was last saved are also included.)

- Status information about the recipient’s post office (including date and time the
message was delivered to the recipient’s post office and the route used)

- Status information about the item in the recipient’s In Box, including the date and time
the item was delivered, opened, accepted, completed, delegated, deleted, forwarded,
or emptied from the Trash

Accessing the Information Window Elsewhere

You can also access the Information window from your Calendar or within an item. After
selecting an accepted item, choose the Actions menu, then choose Info.

In Box Information Window

The In Box Information window provides information about the sender, the item that was
received, and any options that were selected for a specific item when the item was
created.

Resending

If you need an answer to an item, but the recipient has deleted the item without replying,
you can resend it. See Resending and Rescheduling ltems under Out Box.
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Trash &
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Undeleting Items

Control-menu box

Item list box

You can still recover items you have deleted from your Calendar, In Box, and Out Box if
they have not been emptied from the Trash.

From the Main Window,

1 Double-click Trash @
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2 Select the item to undelete from the Item list box.
3 Choose the Edit menu, then choose Undelete to recover the item.

4 Double-click the Control-menu box to return to the Main Window.

Tips and Hints

Where Undeleted Items Appear

An undeleted item will reappear in the Calendar or in the In Box or Out Box folder it was
deleted from. If the folder the item was deleted from no longer exists, the undeleted items
will reappear in the root folder.

Emptying Your Trash &

Emptying your Trash lets you permanently delete all the items currently in the Trash.
Once you have emptied the Trash, you will not be able to recover any items. To discard
only selected items, see Selecting Multiple Iltems under Tips and Hints below.

From the Main Window,

1 Double-click Trash @

2 Choose the Edit menu, then choose Empty Trash to delete all items from your Trash.
3 Choose Yes if you are sure that all items in the Trash should be deleted.

All the items in the Trash will be deleted. This process may take some time.

Tips and Hints

Selecting Multiple Items
You can empty selected item(s) from the Trash.

To select a continuous range of items, click the first item in the range, then Shift-click the
last item in the range.

To select non-continuous multiple items, Ctrl-click the items.

After selecting your items, right-click the selected range to display the QuickMenu, then
choose Empty Selected Items.
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Emptying Your Trash Automatically
You can specify the number of days that items should stay in the Trash before they are

automatically emptied.

From the Main Window, choose the File menu, choose Preferences, then double-click
Cleanup. Select Automatic After from the Empty Trash group box, specify the number of
days, then choose OK. Be aware that your system administrator can set and lock this

option.

= Cleanup Options

Mail and Phone
@ Manual Delete and Archive:

3 Auto-Delete After:

Daps
o Auto-Archive After: D E

Appointment. Task, and Note
@ Manual Delete and Archive
3 Auto-Delete After:
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)] Auto-Archive After: D E

Cancel I

Empty Trash
e Manual

Empty Trash group box
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@ Automatic After:

B

Click these arrows to set the
number of days an item is in the
Trash before it is emptied.

You can recover an item you have placed in the Trash if the Trash has not been emptied.

See Undeleting Items under Trash.
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Accepting or Declining Appointments, Tasks, and
Notes &

Use Calendar to manage your personal schedule and business tasks. You can read and
respond to any incoming requests from your Calendar. There are several pre-designed
calendar views. The Week View is especially useful, because it allows you to look at all
three types of items on a weekly basis.

You can accept or decline appointments, tasks, and notes from either the In Box or the
Calendar.

From the Main Window,

1 Choose the My Calendar pop-up list, then choose a calendar view.

Control-menu box

Window Help
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Week view

2 Double-click the text of a group item in the Appointments, Tasks, or Notes list box to
open the item view.

3 Choose Accept or Decline

4 If you decline, you may want to type a comment in the Comments box, then choose
OK.

GroupWise sends an accept or decline status along with any comments to the sender’s
Information window. See Tracking ltem Information under Out Box.

5 Double-click the Control-menu box to return to the Main Window.

Tips and Hints Accepting with a Comment



